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SQL Server 2005: Reporting Services
Objectives 
 
NOTE:  This lab focuses on the 
concepts in this module and as a 
result may not comply with 
Microsoft security 
recommendations. 
 
NOTE:  The SQL Server 2005 labs 
are based on beta builds of the 
product. The intent of these labs is 
to provide you with a general feel of 
some of the planned features for 
the next release of SQL Server. As 
with all software development 
projects, the final version may differ 
from beta builds in both features 
and user interface. For the latest 
details on SQL Server 2005, please 
visit 
http://www.microsoft.com/sql/2005/. 

After completing this lab, you will be able to: 
1. Create a Report Using the Wizard 
2. Create a List Report 
3. Work with Reports 
4. Manage Security 
 

Scenario 
Reporting Services is a key component in providing a complete 
data management platform for SQL Server users. This lab will 
teach you how to create different types of reports using Reporting 
Services and the SQL Server Business Intelligence Workbench. It 
also covers managing security settings for these reports and the 
different deployment models available. 

Prerequisites 
 Basic working experience with the SQL Server Business 

Intelligence Workbench 
 Basic knowledge of SQL Server security features 

Estimated Time to 
Complete This Lab 

75 Minutes 

 

 

http://www.microsoft.com/sql/2005/
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 Lab Setup 
 

 

Tasks Detailed Steps 

1. Log in. 1. Log in using the Administrator user account. The password is Pass@word1. 
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Exercise 1 
Creating a Report Using the Wizard 
Scenario
In this exercise, you will create a simple report using the Business Intelligence Development Studio.  
To create the report, you will: 
 Create a Business Intelligence Development Studio solution and add a Report Project.  
 Create a tabular report using the Report Wizard.  

SQL Reporting Services report designer is hosted in the Business Intelligence Development Studio environment. It 
provides you with an integrated developer environment for designing, creating, testing, and debugging reports. 
 

Tasks Detailed Steps 

1. Copy the report query. 
 
 

Before creating a report, edit and copy a query using Notepad. This query will be 
used to create a simple report.  
1. Click Start | Run, and then type Notepad.  
2. Select File | Open, navigate to the C:\SQL Labs\Lab Projects\Reporting 

Services Lab directory, select Query.txt, and then click Open. 
Using previously developed queries can save time when creating data sets. It also 
allows users to develop queries using other tools, and then paste the SQL into this 
interface.  
3. In Notepad, select all the text by pressing Ctrl+A and then copy by using 

Ctrl+C. Select File | Exit to exit Notepad without saving the document. 

2. Launch the report 
design environment. 

 
 
 
 
 
 
NOTE:  If the Solution Explorer 
pane is not visible, select 
View | Solution Explorer. 

1. From the Microsoft Windows® task bar, select Start | All Programs | Microsoft 
SQL Server 2005 | Business Intelligence Development Studio. 

Business Intelligence Development Studio provides the environment in which 
Reporting Services reports are designed. 
2. Select File | New | Project. 
3. In the New Project dialog box, in the Project Types pane, verify that the 

Business Intelligence Projects folder is selected. 
Business Intelligence Development Studio allows you to create a blank Microsoft® 
Visual Studio® 2005 solution or to select one of the Business Intelligence templates 
such as Analysis Services Project, Integration Services Project, or Report Project. 
4. In the Templates pane, click the Report Project icon. 
5. In the Location text box, enter C:\SQL Labs\User Projects\. 
6. Uncheck Create directory for solution. 
7. In the Name box, type Bike Reports and then click OK. 

3. Create a new report 
using the report 
wizard. 

 
 
 
 
 
 

A new report can be created using the report wizard.  
1. Select Project | Add New Item. 
2. In the Add New Item page, from the Templates pane, select Report Wizard and 

then click Add. 
3. On the Welcome to the Report Wizard page, click Next. 
4. On the Select the Data Source dialog box, select New data source. Make sure 

that Microsoft SQL Server is selected in the Type drop-down list, and click the 
Edit button. 

5. In the Connection Properties dialog box, in the Server Name text box, type 
localhost. 
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Tasks Detailed Steps 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE:  Fields can be added to 
the other sections of the report 
either by using the Page and 
Group buttons or by dragging 
and dropping the fields into 
the appropriate boxes. 

6. Under Log on to the server, select Use Windows Authentication. 
7. In the Select or enter a database name drop-down list, select 

AdventureWorksDW, and then click OK. 
8. Verify that the local server (localhost) and AdventureWorksDW database are 

both listed in the connection string. Click Next. 
9. In the Design the Query page, paste the text from the Notepad query in the 

Query String text box by clicking the Query String box and pressing Ctrl+V.  
10. At the end of the existing query, insert a new line, and then type: 
 
WHERE EnglishProductCategoryName = 'Bikes' 

 
11. Click Next to move to the next page. 
12. In the Select the Report Type page, verify that Tabular is selected, and then 

click Next. 
13. In the Design the Table page, in the Available Fields list, select 

EnglishProductName, then click Details. Repeat for SalesAmount. Click Next. 
The previous step adds the selected fields to the Details section of the report. 
14. In the Choose the Table Style page, click Next. 
15. In the Completing the Wizard page, leave Report1 as the report name and click 

Finish. 

4. Modify the Report 
Layout. 

 
 
 
 
 
 
 
 
 
 
 
NOTE:  Reporting Services 
may take a few moments to 
preview the report. 

1. In the Layout view, in the Body section of the report, click inside the table (for 
example, on the EnglishProductName label). 

2. Move the cursor over the table column divider (in the grey bar above 
EnglishProductName and SalesAmount) until it changes to a double arrow. Click 
and drag the column width for the EnglishProductName column until it is 
approximately two inches wide. 

3. Click on the Report1 title, and replace the text with “Bike Price Report.” Adjust 
the field width so that it is wide enough to display the whole title. When you’re 
done, the report should look like Figure 1. 

 
Figure 1: Completed report design 
4. Select File | Save All. 
5. In the View pane, click Preview. 
A list of bikes with sales amounts will be displayed. 

5. Close the Business 
Intelligence 
Development Studio 
environment. 

1. Select File | Exit. Do not save any files when prompted. 
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Exercise 2 
Creating a List Report 
Scenario
In this exercise, you will create a simple report using Business Intelligence Development Studio and deploy that 
report to the SQL Server Reporting Services report server. 
To create the report, you will: 
 Create a Business Intelligence Development Studio solution and add a Report Project. 
 Create a Data Set. 
 Set up a query from a Data Set. 
 Design the layout of a report. 
 Deploy the finished report to the Report Server. 

SQL Reporting Services report designer is hosted in the Business Intelligence Development Studio environment. It 
provides you with an integrated development environment for designing, creating, testing, and debugging reports.  
 

Tasks Detailed Steps 

1. Launch the report 
design environment. 

 
 
 
 
 
 
 
 
 
 
Tip:  If the Solution Explorer 

pane is not visible, click 
View | Solution 
Explorer. 

1. Click Start | All Programs | Microsoft SQL Server 2005 | Business 
Intelligence Development Studio. 

Business Intelligence Development Studio provides the environment in which 
Reporting Services reports are designed. 
2. Choose File | New | Project. 
3. In the New Project dialog box, in the Project Types pane, verify that the 

Business Intelligence Projects folder is selected. 
Business Intelligence Development Studio allows you to create a blank Visual Studio 
2005 solution or to select one of the Business Intelligence templates such as Analysis 
Services Project, Data Transformation Project, or Report Project. 
4. In the Templates pane, select Report Project. 
5. In the Name box, type AWReports. 
6. In the Location box, enter C:\SQL Labs\User Projects and then click OK. 
7. In Solution Explorer, right-click AWReports, and select Add | New Item from 

the context menu. 
8. In the Add New Item – AWReports dialog box, in the Templates pane, select 

Report (not Report Wizard). 
9. In the Name text box, enter AWSales.rdl, and then click Add. 

2. Create a new Dataset 
 
 
 
 
 
 
 
 
 

All reports need to have associated data. This source data information is created in a 
Dataset. 
1. At the top of the report designer, click the Data tab if it's not already selected. 
The data view provides the tools to set up the Dataset and create the query 
information you wish to report. 
2. In the Dataset drop-down list, click <New Dataset…>. 
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Tasks Detailed Steps 
 
 
 
 
 
 
 
 
 
Warning:  Be sure there are no 
spaces in your DataSet name. 

 
A dataset represents the specific fields queried from a data source. Multiple datasets 
can be created using a single source.  
3. On the Data Source dialog box, make sure that Microsoft SQL Server is selected 

in the Type drop-down list, and click the Edit button. 
4. In the Connection Properties dialog box, in the Server Name text box, type 

localhost. 
5. Under Log on to the server, select Use Windows Authentication. 
6. In the Select or enter a database name drop-down list, select 

AdventureWorksDW, and then click OK. 
7. Verify that the local server (localhost) and AdventureWorksDW database are 

both listed in the connection string. Click OK. 
8. Click the ellipsis (…) button to the right of the Dataset drop-down list. 
9. In the Dataset dialog box, in the Name text box, replace the existing text with 

“SalesData”. (Do not type the quotes.) 
10. Keep the dialog open and continue to Task 3. 

3. Create a query for the 
Data Set. 

1. From the Windows task bar, click Start |Run and type Notepad. 
2. Choose File | Open and navigate to the C:\SQL Labs\Lab Projects\Reporting 

Services Lab directory. Select Query.txt, and then click Open.  
Using previously developed queries can save time when creating data sets. This also 
allows users to develop queries using other tools, and then paste the SQL into this 
interface.  
3. In Notepad, press Ctrl+A to select all the text, press Ctrl+C to copy the text to 

the clipboard, and then close Notepad. 
4. Switch back to Business Intelligence Development Studio and paste the text in 

the Query String text box of the DataSet dialog box by clicking the Query 
String box, and pressing Ctrl+V. 

5. Click OK to close the Dataset dialog box. 

4. Create the first List 
Object. 

 
 
Tip:  By default, the Toolbox is 
located on the left side of the 
screen. If the Toolbox window 
is not visible, select View | 
Toolbox. 
Important:  If the Fields 
window is not already open, 
select View | Fields. 
 
 

1. In the View pane, click the Layout tab. 
2. In the Layout pane, move the mouse pointer to the bottom edge of the report grid. 

When the mouse pointer changes into a vertical double-arrow icon, click and 
drag downward to enlarge the report grid. 

3. In the Toolbox window, double-click the List item in the Report Items group. 
This will place an instance of the List control on the report design surface. 

4. With the new List control still selected, click and drag the lower-right corner of 
the control so that the control fills the width of the entire design surface and is 
about one inch tall.  

5. In the DataSets window, click the + next to SalesData to see the list of fields.  
6. Drag EnglishProductCategoryName from the DataSets window to the upper 

left corner of the List area in the report grid. Click and drag the right edge of the 
field’s text box to make it approximately two inches wide. 

7. With the EnglishProductCategoryName text box selected, press F4 to display the 
Properties window with properties for this control. 
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Tasks Detailed Steps 
8. In the Properties window, click the Font property. Expand the Font property to 

display the FontWeight property. Change the FontWeight property from 
Normal to Bold. 

9. Click inside the List area.  
10. In the Properties window, select the Grouping property, and then click the 

ellipsis button to the right of the property value. 
11. In the Details Grouping dialog box, in the Expression list, click on the first row 

then expand the drop-down list. Select 
=Fields!EnglishProductCategoryName.Value, and click OK. 

12. In the DataSets window, click SalesAmount and drag it from the Fields window 
to the upper right corner of the List area. 

13. Expand the two text boxes vertically so that the expressions are visible, and 
verify that they match Figure 2. 

 
Figure 2: The completed layout. 
 
14. Click on the SalesAmount text box to select it.In the Properties window, in the 

Format property text box, type 0,0.00 
15. Select File | Save All. 
16. In the View pane, click the Preview icon. The results should look like Figure 3. 
17. The report will generate and then show the three categories and a sales amount 

total for each category. 

 
Figure 3: The report in its current state. 

5. Create the second List 
Object. 

 
 
 
 

1. In the View pane, click Layout. 
2. Expand the List control to fill the entire design surface. 
3. Click the Toolbox tab at the bottom left corner of the main window. After the 

Toolbox appears, click List. Use the mouse to drag a rectangle that covers the 
area inside the first List area and under the text boxes just added to the first List 
area. Make sure that you leave some space between the text boxes and the new 
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Tasks Detailed Steps 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE:  Reporting Services 
may take a few moments to 
preview the report. 

List area. Use Figure 4 as your guide. 

 
Figure 4: Layout for the second List control 
 
Nesting list objects facilitates grouping and sorting operations. 
4. If the DataSets window is not visible, select View | Datasets.  
5. From the DataSets window, drag EnglishProductSubCategoryName to the 

upper left corner of the second (inner) list area. Click and drag the right edge of 
the text box to make it approximately two inches wide. 

6. Click inside the second list area. In the Properties window, click the Grouping 
property, and click the ellipsis button to the right of the property value (…). 

7. In the Expression list, click on the first row, expand the drop-down list, and then 
select =Fields!EnglishProductSubCategoryName.Value. Click OK. 

8. In the first (outer) List area, right-click the SalesAmount text box. Click Copy, 
right-click inside the second (inner) List area, and then click Paste. Drag the 
SalesAmount textbox to the upper right corner of the inner List area. 

9. Select File | Save All. 
10. In the View pane, click Preview. 
Both a category and a list of subcategories with corresponding sales amounts are 
displayed. 

6. Create the third List 
object. 

 
 
 
 
 
 

1. In the View pane, click Layout. 
2. Click the Toolbox. In the Toolbox window, click List. Drag a rectangle that 

covers the area inside the second List area under the text boxes just added to the 
second List area. 

3. If the DataSets window is not visible, select View | Datasets.  
4. From the DataSets window, drag EnglishProductName to the upper left corner 

of the third List area. Drag the right edge of the text box to make it 
approximately two inches wide. 

5. From the DataSets window, drag the SalesAmount field to the upper-right corner 
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Tasks Detailed Steps 
 
 
 
 
 
 
 
 
 
 
 
NOTE:  Depending on your 
individual report design, you 
may need to adjust your 
spacing in the Layout pane to 
achieve optimal report layout. 
A good rule of thumb is to 
make sure that the list areas 
are just big enough to house 
the text boxes without 
overlapping. 

of the third List control. 
6. Click on the SalesAmount text box to select it. In the Properties window, in the 

Format property text box, type 0,0.00 
7. Click inside the third List area. In the Properties window, click Grouping and 

then click the ellipsis (…) button. 
8. In the Details Grouping dialog box, in the Expression list, click on the first row, 

expand the drop-down list, and select =Fields!EnglishProductName.Value. 
Click OK. 

9. Reduce the size of the third List area to cover just around the text boxes, reduce 
the size of the second List area to cover just around the third List area, and reduce 
the size of the first List area to cover just around the second List area. The 
finished report should look like Figure 5. 

 
Figure 5: The finished report contains three list areas. 
 
10. Select File | Save All. 
11. In the View pane, click Preview. 
All the detail for the category, subcategories, and products will be displayed. 

7. Add Page Breaks to 
the Report. 

This report contains many lines of data and may be easier to read if it is broken into 
pages. 
1. In the View pane, click Layout. 
2. Click inside the first (outermost) List area. In the Properties window, select the 

Grouping property, and then click the ellipsis (…) button. 
3. In the Details Grouping dialog box, select Page break at end, and then click 

OK. 
4. Select File | Save All. 
5. In the View pane, click Preview. 
Your report will begin each category listing with a fresh page. You can use the page 
arrows in the Preview pane to navigate between pages of the report. 

8. Create Parameters for 
a Report. 

 
 
 
 
 
 
 
TIP:  If the report does not 
return any records, retry Step 
4, ensuring that you type 

Parameters can be used to further control the report’s data. For example, the product 
category managers want to view the sales for their specific category. To meet each 
manager’s reporting needs, define a product category at run time by specifying a 
parameter value. This allows the same report to be customized for each product 
category manager.  
1. In the View pane, click on the Data icon. 
2. In the SQL pane, move the cursor to the end of the SQL query, add a new line, 

and then type: 
WHERE EnglishProductCategoryName = @Category 

3. In the View pane, click on the Preview icon. 
4. At the top of the Preview designer, in the Category text box, type Bikes, and 

then click View Report. 
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Tasks Detailed Steps 
Bikes in the Category text 
box. 

The category parameter will limit the report to just the Bikes category. 
5. Select File | Save All. 

9. Deploy a report to the 
Report Server. 

Once the development of the report or project is completed, it can be deployed from 
the Business Intelligence Development Studio environment to the Report Server Web 
application where it will be available to end users. 
1. Select Build | Configuration Manager. 
2. In the Configuration Manager dialog box, set the Active Solution Configuration 

to Production. 
3. Click Close to dismiss the dialog box. 
4. In the Solution Explorer, right-click the AWReports project and then select 

Properties from the context menu. 
5. In the AWReports Property Pages dialog box, under Deployment, in the 

TargetServerURL text box, type http://localhost/reportserver and then click 
OK. 

6. Select the Build | Deploy Solution menu item. Watch the Output window for 
status on the deployment. 

Once the deployment has completed, you can view the report in a Web browser. In 
the next exercise, you will browse deployed reports. 

10. Close the Business 
Intelligence 
Development Studio 
Environment. 

1. Select File | Exit. 

 

http://localhost/reportserver
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Exercise 3 
Managing Security 
Scenario
In this exercise, you will modify security settings for both the Report Server application and for a specific report by 
using the Microsoft SQL Server Reporting Services Web application interface. 
In this exercise, you will: 
 Create a system-level security role. 
 Apply a new system role to a group. 
 Create an item-level security role. 
 Apply a new item-level role to a report. 

The security roles used by the Report Server Application use the groups and users set up in the Windows operating 
system. 
 

Tasks Detailed Steps 

1. Create a new system 
role. 

 
 
 
 
 
 
 
NOTE:  You may safely ignore 
any Internet Explorer error 
message that may appear at 
this step. 

1. From the Windows task bar, click Start | All Programs | Internet Explorer. 
SQL Server Reporting Services is a Web application and is administered by using a 
browser. 
2. In the address bar, type “http://localhost/Reports”. 
3. In the upper-right corner of the browser screen, click the link for Site Settings. 
4. In the Security section near the bottom of the page, click Configure 

system-level role definitions. 
System Roles define the system level actions and permissions a group or user is 
allowed. This includes permission to manage security, roles, shared schedules, and 
server properties. These are inherited from their parent folder by default, but they can 
be changed on an item-by-item basis. 
5. Click the New Role button near the top of the page. 
6. In the Name text box, type “Report Analyst”. 
7. In the Description text box, type “May view server properties and manage 

shared schedules”. 
8. In the Select one or more tasks to assign to the role section, select Manage 

shared schedules, View report server properties, and View shared schedules.
Figure 1 shows the completed page 

 

 
Figure 1: Selected tasks for the new role. 
9. Click OK to save the changes. 

http://localhost/Reports
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Tasks Detailed Steps 

2. Create a new Item-
level security role. 

Access to a report can be fine-tuned for specific groups or users by creating item-level 
roles that grant different permissions from the default permissions created when a 
report is first deployed. 
1. Click Site Settings. 
2. Under Security, click the Configure item-level role definitions link. 
Roles define the item-level actions and permissions a group or user is allowed. This 
includes permissions to manage a report’s history, subscriptions, data sources, folders, 
and security. 
3. Click the New Role button. 
4. In the Name text box, type ReadOnly. 
5. In the Description text box type “May only view server objects”. 
6. Select the check boxes for View data sources, View folders, View reports, and 

View resources, and then click OK. Figure 3 shows the completed page. 

 
Figure 3: Selected tasks for the ReadOnly role. 
 
7. Click the Home link, click AWReports, and then click AWSales. 
8. Click the Properties tab. On the left-hand side of the screen, click the Security 

link, and then click the Edit Item Security button at the top of the window. 
Permissions are inherited from their parent folder by default. Changing the default 
permissions opens an information dialog box asking the user if they want to break the 
inheritance of these permissions. 
9. In the Microsoft Internet Explorer message box, click OK. 
10. Click the Edit link to the left of the BuiltIn\Administrators label. Clear all 

selected items, check the ReadOnly box, and then click Apply, as shown in 
Figure 4. 
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Tasks Detailed Steps 

 
Figure 4: Assignments for the ReadOnly role 
 
All users in the Administrators group set up in Windows will now only have the 
ReadOnly permissions created above for the report. 
The original report permissions can be restored by clicking Revert to Parent 
Security. 
11. Click the View tab. 
12. In the Category text box, enter “Bikes”. Do not type the quotes. 
13. Click the View Report button.  
14. Close Internet Explorer. 
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